LEARNING OBJECTIVES

Chapter 3 continues the discussion on theories of crime causation but narrows the scope to theories and approaches that use both individual behaviors and physical characteristics of space to explain crime. As discussed in the previous chapter, the physical characteristics of an environment communicate social clues to the people who live, work, and play there. These clues provide potential offenders and victims with information about how they should behave to ensure their safety, pleasure, and the successful fruition of their interests. For offenders, these clues identify the method by which they might commit a crime successfully and avoid getting caught. For potential victims, these clues provide information about how to avoid being victimized. This chapter reviews several theoretical approaches that are used in developing environmental design aspects to prevent crime. These aspects include lighting, landscaping, natural surveillance and crime prevention boundaries, and building design, to name a few. After studying this chapter, you should be able to:

• Identify and explain core elements to CPTED approaches.
• Explain the basic tenants to rational choice perspectives.
• Explain the Crime Pattern Theory.
• Explain and discuss the Routine Activities Theory and its utility in understanding and analyzing crime.
• Discuss lifestyle exposure approaches and understand their utility in understanding repeat offenses and repeat victimization.
• List and describe the types of crime displacement, and discuss the relevant research that examines the existence (or lack) of crime displacement.
• Explain the concept of diffusion of benefits and its utility in understanding crime patterns.

KEY TERMS

Activity Space
Awareness Space
CPTED
Crime Displacement
Defensible Space
Diffusion of Benefits
Event Dependency
Hedonism
Risk Heterogeneity
Victim Facilitation
Victim Precipitation
Victim Provocation
Virtual Repeats

Introduction

Chapter 2 discussed several theoretical frameworks that identify the social and physical incivilities that are important in understanding community-level crime rates. These theories emphasize the flaws in the physical environment and the gaps in social networks that are
common to high-crime areas. These theories also identify characteristics of individuals who are typically found (residing or working) in socially disorganized neighborhoods. This chapter narrows our focus to the individual characteristics and the physical properties of space related to crime and victimization through the creation of increased opportunities for motivated offenders to commit crime. Every person has routines and rhythms of their daily lives that become part of us. Have you ever been so absorbed by a project at work that on some Saturday or Sunday your significant other has asked you to run an errand, and you found yourself on the way to work or even pulling into the place where you work when you had intended to go to the store? That drive back and forth to work has become an important part of your social makeup. On our way to our activities and employment, we may look around and see a new construction site and ask ourselves, “I wonder what they are building there?” People who are prone to crime and hunting for targets do the same thing, only their question might be, “I wonder if that compressor is locked up or if I could steal it later tonight?”

Using environmental design to control human behavior is not only popular in developing crime prevention efforts; it is also used in the private sector to increase profit margins. Casinos, for example, are strategically designed to keep people gambling for as long as possible. Big casinos incorporate several design aspects to keep customers happy, comfortable, and gambling. For example, carpets exhibit bright, elaborate, and fun designs, while pumped-in oxygen, mirrors, and bright lights create a stimulating environment that makes it difficult to be bored or sleepy. Alcoholic drinks are also served 24 hours a day, often free of charge, to gambling patrons by casino staff members who are typically dressed in “barely there” outfits. Event halls and auditoriums are located adjacent to gambling areas, requiring patrons to walk through those areas upon arrival and departure. Even arrival to and departure from the Las Vegas airport requires people to walk past slot machines!

One does not have to look further than a local supermarket to grasp the concept of environmental design and how it impacts human behavior. In another example outside of criminal justice, to pick up a gallon of milk at a grocery store, customers must walk to the far corner of the store, usually past impulse and convenience food items, to reach the milk section. Knowing that people are likely to pick up milk on their way home from work (and are probably hungry and tired), the store places various snack foods and ready-to-eat items on the path to commonly needed items (such as milk) in an effort to increase sales.
The notion of physical design to control behavior, particularly criminal behavior, is also not new. Attention in both the academic and practical realm shifted to the physical environment and how it could be modified to control human behavior when crime increased exponentially in the late 1960s and early 1970s. Jane Jacobs (1961) was one of the first researchers to propose a relationship between crime and the urban city environment. In her book *The Death and Life of Great American Cities*, she made several observations about crime and the physical environment. She was also one of the first to suggest that the physical environment could be manipulated by improving the natural surveillance (the ability of the persons living in an area to be aware of what is going on in their portion of the neighborhood) of an area to reduce crime. Other researchers during this time period, including Elizabeth Wood (1961) and Schlomo Angel (1968), focused their research on the effects the physical environment could have on human behavior and how environments could be manipulated to achieve social objectives.

The point to environmental design is to guide, manipulate, and/or encourage people to behave in a desirable manner in a given situation. In neighborhood crime control strategies, this can mean a variety of things. First, the environment needs to be created in a way that encourages informal social control efforts by the people who work and reside in a neighborhood. An example of informal social control is the existence of a block watch group in a neighborhood. All of the neighbors actively participate in reporting, interceding, or watching their portion of the neighborhood for criminal or socially unacceptable behavior. They cannot literally arrest someone, in most cases, but they can give the impression to unauthorized persons in the neighborhood that everything they are doing is being watched and will be reported to the police. Second, the physical properties of a space should allow for maximum visibility so that residents can observe what is happening in their surroundings. Third, environmental clues emanating from the neighborhood should send the message to outsiders and potential offenders that committing crimes in this place would be risky and unprofitable. A very important point here is that the interaction of physical design and informal social control are what creates an environment that is resistant to crime. If the environment cannot control human behavior in the way in which it was intended, the design aspects examined in this chapter will likely have few affects on crime.
The CPTED Approach

Let us first examine crime prevention through environmental design (CPTED) approaches. CPTED suggests that the design of physical space is important in understanding criminal behavior. C. Ray Jeffrey (1971) and his contemporary Oscar Newman (1972) are credited with providing the foundations that outline how physical space should be designed to maximize its crime prevention potential.

Newman’s Defensible Space

Through the Safe Streets Act of 1968, grant funding was made available to research new crime-prevention efforts. The focus of Newman’s research on crime-prevention strategies in public housing projects emphasized how architectural design could play a role in reducing crime. Newman’s defensible space model argues that physical space can be structured in a way that fosters and reinforces a social structure that defends itself. Newman, focusing his work primarily on housing projects, suggested that by improving natural surveillance and encouraging tenants to assume responsibility for the public areas within the housing project, boundaries might reduce crime due to an increase in the risk of observation. Newman identified four key elements of defensible space: territoriality, natural surveillance, image, and milieu.

Territoriality refers to the ability of legitimate users of an area or physical space to frequently use and to protect the space from non-legitimate users. For example, an outdoor courtyard nestled within several apartment buildings might have walkways and benches for people to use at their leisure. However, if legitimate users (residents of the apartment buildings) do not use the space, others, perhaps nonlegitimate users, may use the space in ways that are harmful.

Natural surveillance involves designing physical space in a way that allows legitimate users to observe the behaviors of friends and strangers. In theory, this allows residents to augment and bolster law enforcement by being the eyes and ears of police and by taking action against criminal and/or other socially undesirable activities. Action could include calling the police or intervening when appropriate. Image has to do with fostering a neighborhood environment that creates the appearance that the neighborhood is well cared for and is not isolated from the communities that surround it or the people who inhabit the area. Environmental design of this type might include landscape lighting, clean grounds and garbage receptacles, working fountains, and manicured lawns and bushes. A great example of this is the many fantastic squares of historic Savannah, Georgia. There, the squares serve as tour-
ist attractions, historic landmarks, resting and conversational spots, and speed constraints. When one thinks of Savannah, the beauty and romance of her squares surely create the imagery. The socially disorganized neighborhoods that are discussed in the previous chapter serve as good examples of what the concept of the image is not. Last, *milieu* (the French word for “environment”) involves placing an area within a larger community or physical space that contains territoriality, natural surveillance, and image, creating a defensible space that remains free of criminal activity. If a neighborhood with defensible space borders neighborhoods without defensible space, milieu is not achieved. One might think of this as the total social landscape of a neighborhood or a group of neighborhoods that border each other. In other words, if you drive through your own neighborhood and adjacent neighborhoods today, what would you find there? Would all of the homes be clean, well cared for, and project the image of the entire neighborhood, or would there be some homes with uncut grass, shabby paint, or trash in the front yard?

Newman’s work focused on a comparison of public housing projects in New York City. In his study, he examined several variables, including access points, the ability of residents to observe, the size of the project, and the building structure itself. He concluded that defensible space could be accomplished in public housing projects by installing doors and windows in places that allow for increased observation of surrounding areas by the residents. In addition, he argued that installing better lighting and creating common areas that residents could both use and control would also bolster crime prevention because residents would be better able to see the behaviors of legitimate and nonlegitimate persons and could thus take action when necessary. Newman identified four types of zones:

- **Public spaces:** These are areas that are open to the general public and serve a variety of uses, such as a public street.
- **Seminprivate spaces:** These include areas that are more restricted in use, such as an apartment hallway or stairwell, which are open to nonresidents but are most often used by residents and their friends or families.
- **Private spaces:** Most notably the apartments themselves, these are areas that are not open to the public and are restricted to the use of residents and their friends or families.
In comparing two adjacent housing projects (one with and one without defensible space characteristics), Newman found that the project without defensible space had both higher maintenance costs and higher crime. He extended his research to include analyses of more than 100 housing projects in New York City and reported that there was enough substantial evidence to conclude that physical design aspects have important consequences regarding crime and disorder. Newman was also opposed to high-rise projects and argued that public housing should include as much private space as possible. Newman theorized that this would move people to maintain more guardianship over the spaces in and around their residences.

Subsequent tests of defensible space in other cities mirrored Newman’s results. An examination of residential burglary in Boston identified several physical site characteristics that were important in predicting which homes were more likely to be victimized (Reppetto, 1974). Wilson (1978), in his analysis, found that areas of London that lacked defensible space characteristics suffered more incidents of vandalism.

Newman added much to the study of crime and its relationship to the physical environment, but his work is not without criticism. He has been criticized for ignoring the social elements of tenants in housing projects and of those residents in surrounding areas. That is, the physical design elements, while important, may offer far less value in predicting crime rates than social level variables. Taylor et al. (1985) found that the relationship between crime and physical design features was spurious and that neighborhood social status was much more predictive of crime. Merry (1981) also touched on the fact that while environments could certainly be redesigned to better suit defensible space, residents must want to assume a role in the guardianship of the space. Furthermore, her results suggest that physical design strategies may not be entirely effective in spaces with heterogeneous (culturally, racially, or ethnically diverse) populations.

CPTED: Theory and Research

In Crime Prevention Through Environmental Design, C. Ray Jeffery examined design aspects that contribute to crime prevention and how they could be applied in nonresidential areas, such as schools, to control human behavior. By incorporating elements of behavioral learning theory, Jeffery argued that the removal of reinforcements for crime from schools would reduce incidents of crime. While Jeffery’s original model has been revised, the basic concept of crime prevention through environmental design (CPTED) is that by changing the
environment (stimulus) we can change the behavior of the offender (response). Crowe (2000) outlines the assessment of CPTED with what he calls the “Three-D approach.” Essentially, the Three-D approach is based on the notion that human space is designed to fulfill three functions (Crowe, 2000, p. 39):

- All human space has some designated purpose.
- All human space has social, cultural, legal, or physical definitions that prescribe the desired and accepted behaviors.
- All human space is designed to support and control the desired behaviors.

Space, then, can be evaluated based on designation, definition, and design. Table 3-1 utilizes the Three-D approach to assess a well-known theme park as a useful example. Essentially, space that is designated with a specific goal in mind, that is well defined, and that is designed appropriately for the purposes it was intended is least likely to experience crime or other socially undesirable behaviors. From the perspective of a theme park, spaces that are designed to provide hours of family fun with well-maintained areas for visiting, playing, eating, and shopping encourage people to engage in the structured fun that is provided. Furthermore, signs, landscaping, lighting, and other physical design features tell park visitors which activities are appropriate and which are inappropriate.

Kushmuk and Whittemore (1981) argue that there is an indirect relationship between crime and the physical design of the environment and that these changes operate through four intermediate goals: improved access control, surveillance, activity support, and motivation reinforcement. Their model is similar to Newman’s defensible space. Good access control exists when we have the ability to regulate who enters and exits an area or building. Surveillance is the ability for the legitimate users of a space to observe their surroundings. Activity support and motivation reinforcement have to do with creating a community atmosphere where people feel vested in their neighborhood and watch out for one another. Kaplan et al. (1978) propose that opportunity, target, risk, effort, and payoff (OTREP) explain variations in crime across people and places. This model assumes that offenders are rational and that if physical design changes limit opportunities by increasing the risk and effort and reducing the payoff, crime will decrease. Thus, physical design elements that increase the offender’s risk of getting caught or increase the effort required to commit the crime will, in theory, reduce the likelihood of crime.
### TABLE 3–1 The Three-D Approach: Anywhere Theme Park, USA

<table>
<thead>
<tr>
<th>Designation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is the designated purpose of this space?</td>
<td>Family entertainment for people of all ages. This space also caters to people with disabilities.</td>
</tr>
<tr>
<td>What was it originally intended to be used for?</td>
<td>Family entertainment, same as above.</td>
</tr>
<tr>
<td>How well does the space support its intended use?</td>
<td>Very well. Park designed with a high degree of safety and security for the patrons. Park structures are properly gated, metal is coated with rust-resistant, thick paint, and structures are designed with few hard or sharp edges. Grounds are kept in neat and safe order, trash is properly contained, and parking lots are well lit and well attended by live personnel and CCTV. Fences and gates are locked and signed as needed, pathways are relatively free of tripping hazards, restroom facilities are well marked and placed in numerous locations. Ride lines are housed under roofs and are relatively out of the weather. Exit routes are well marked, and emergency staff is on duty all open hours.</td>
</tr>
<tr>
<td>Is there conflict?</td>
<td>No. Nothing in the park suggests the area is to be intended for anything other than family entertainment. There is no structure, pathway, or area designed for anything unrelated to family entertainment or the administration of the park.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Definition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>How is the space defined?</td>
<td>Spaces are defined with clear pathways and borders, signs, lighting, music, and themes. Also, a wide array of colors is used to mark specialized areas, such as first aid and restaurant areas.</td>
</tr>
<tr>
<td>Is it clear who owns it?</td>
<td>Yes. Theme park insignia and corporate logos are everywhere. Ownership is a sense of pride.</td>
</tr>
<tr>
<td>Where are its borders?</td>
<td>The park has fencing and heavy signage around its perimeter. Individual areas within the park use landscaping, walkways, and physical obstacles, such as a waterway or animal enclosures and fencing, to define borders. In some areas the space is designated by music and the design of buildings. Generally an omnipresent theme designates each area, such as that of the food court, small children's area, gaming area, and general ride area.</td>
</tr>
<tr>
<td>Are there social or cultural definitions that affect how that space is used?</td>
<td>Yes. The culture of this park is about innocent family fun. Themes of friendship, fun, and happiness abound. Characters are typically on display and act as ambassadors of kindness, fun, and imagination. Nowhere will one find a theme related to negativity or harmfulness. Even those characters who may be thought of as harmful in the real world (such as pirates) are friendly, full of spirit and adventure, and neglect to harm a soul. While stereotypes of sexism may be observed, traditional gender roles are often combined, resulting in male heroes who take care of infants or female warriors who also take care of their families. Elements of racism are stricken in exchange for themes of multiculturalism and diversity.</td>
</tr>
</tbody>
</table>
### Definition (continued)

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Are the legal or administrative rules clearly set out and reinforced in policy?</td>
<td>Rules are clearly printed on park handouts, such as maps and signs. There is ample staff present to enforce the rules, and all seem keenly aware of various restrictions and park guidelines. Visitors are searched upon entering the park to prevent various items from entering the park, identification is required to purchase tickets, close monitoring is conducted via CCTV.</td>
</tr>
<tr>
<td>Are there signs?</td>
<td>Yes. For every occasion, at every turn.</td>
</tr>
<tr>
<td>Is there conflict or confusion between the designated purpose and definition?</td>
<td>No. Each area is specifically designed for its purpose. This not only creates a richer guest environment but facilitates the movement of people through the area, increasing its overall productivity. The numbers of people who use these areas are too great to allow confusion. This would create a bottleneck in the flow of foot traffic and general dissatisfaction among the guests.</td>
</tr>
</tbody>
</table>

### Design

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>How well does the physical design support the intended function?</td>
<td>Very well. The color, design, and landscaping set the mood of family fun. Colors and characters are age appropriate, music is thematic, and structure sizes are appropriate to the user. There are no structures that do not contribute to the theme of the area or the park. Walkways are wide and well lit, clean, and level. Exits are clearly marked, doorways are well marked and wide, and walkways are indirect, leading to a sense of exploration and bigness.</td>
</tr>
<tr>
<td>How well does the physical design support the definition of the desired or accepted behaviors?</td>
<td>Very well. There are signs everywhere indicating directions, rules, and suggestions for park visitors to follow. Rides, games, and sitting areas are clearly separated or integrated, depending on the design of the area. Facilities and distractions are properly restricted where movement and traffic flow is necessary.</td>
</tr>
<tr>
<td>Does the physical design conflict with or impede the productive use of space or the proper functioning of the intended human activity?</td>
<td>No. All facilities and structures contribute to the purposeful movement of traffic. Again, restrictions are kept to a minimum so as not to create a greater problem in traffic management.</td>
</tr>
<tr>
<td>Is there confusion or conflict in the manner in which the physical design is intended to control behavior?</td>
<td>No. All facilities are designed to control and direct large amounts of traffic. Confusion would hinder the operation and productivity of the park.</td>
</tr>
</tbody>
</table>
In their review of the literature, Rosenbaum et al. (1998) divide CPTED strategies into the categories of target hardening measures, access control strategies, surveillance enhancement efforts, and community-building measures. Target hardening measures appear to be fairly successful in increasing the effort and risk for potential offenders. Measures including deadbolt locks, solid-case doors, window restrictions, steering column locks on cars, and alarms have all produced some measurable decrease in specific crimes. Access control measures can also be successful but may be difficult to implement. Research suggests that buildings and areas with multiple access points (and limited surveillance) have more crime. The most common type of surveillance enhancement is to increase lighting. However, the jury is still out on whether or not simply improving lighting is effective in reducing crime. Research in this area has found conflicting results. (See Farrington and Welsh, 2002, for a summary of the literature.) One reason for these conflicting results may be how improved lighting is operationalized. Another issue is the choice of crime measurement (Chapter 6 examines the strengths and weaknesses of different data sources). Pease (1999) suggests that lighting may reduce crime if it increases outdoor activities, which then increases surveillance abilities. In addition, lighting increases visibility and thus increases the risk to the potential offender.

The use of closed-circuit television (CCTV) for surveillance has grown in popularity in recent years, especially in England. In an evaluation of 13 CCTV ventures, Gill and Spriggs (2005) found mixed results on its ability to thwart crime. In some cases, areas with CCTV sustained more crime than control areas, and in other cases CCTV-equipped areas sustained less crime than the control areas. An interesting report by Jane Black (2003) in Business Week suggests that British residents are fed up with the use of CCTV cameras (used primarily for catching speeders) and that:

The destruction of these surveillance cameras—which cost between 30,000 to 50,000 British pounds each (between $50,000 and $80,000)—has become a near-weekly occurrence in the British Isles. Farmers in Somerset have been charged with using speed cams and closed-circuit TV cameras (CCTV) for target practice. In Cambridgeshire, vandals set one afire. Earlier this month, one creative hooligan knocked down a speed cam by attaching a rope from the back of his car to the camera’s pole and driving away—a mini reenactment of the toppling of Saddam’s statue in Baghdad.

Furthermore, “Ten years later, it is clear that CCTV has done little to clean up the streets. Study after study shows that CCTV simply
displaces crime to areas where no cameras are present rather than preventing it” (Black, 2003).

Lastly, well intentioned efforts designed to build community cohesion have found varying levels of success and failure. This may be in part due to the operationalization of key variables. For example, what exactly is a “community”? In addition, a primary assumption of CPTED approaches are that changing the physical environment will change the social environment. What happens if courtyards are constructed, benches are placed, and lighting improves, but the legitimate users of an area still do not use the spaces?

Felson and Clarke (1998) outline 10 principles of opportunity—the cornerstone for all criminal behavior. Essentially, opportunities are important in understanding crime, and these opportunities are usually highly specific, concentrated in time in space, and dependent on everyday movements. In addition, opportunities for crime differ with social and technological changes, and some opportunities are more tempting than others. Furthermore, crime opportunities can be reduced, producing significant impacts on crime with little to no displacement. The theoretical approaches framing these 10 principles of opportunity include the Rational Choice, Routine Activities, and Crime Pattern Theories.

**Rational Choice Theory**

The roots of rational choice perspectives can be traced back to the Classical School of Criminology. Recall that the major premise of the Classical School of Criminology is that offenders choose to commit crime based on their perceptions of risk and reward. Thus, offender behavior is guided by *hedonism*, the principle of pleasure versus pain. Essentially, criminals make decisions based on what is best for them at the time, seeking pleasure and avoiding pain. Sounds simple, right?

Recent rational choice perspectives argue that offender decisions are based on the perceived effort and rewards in comparison to the consequences of committing crime, including the likelihood and severity of punishment (Cornish & Clarke, 1986, 2003). Modern rational choice theorists identify multiple factors in offender decision making, including time constraints, cognitive ability, and available information. These theorists argue that decision making must be examined from a crime-specific focus. In addition, theorists contend that criminality...
and crime are fundamentally distinct concepts and must be separated under analysis. For example, Cao (2004) states that:

Crime is an event; criminality is a personal trait. Criminals do not commit crime all the time; noncriminals may on occasion violate the law. Criminal involvement refers to the processes through which individuals choose to become initially involved in particular forms of crime, to continue, and to desist. The decision processes at these three stages are influenced by different sets of factors and need to be separately modeled. Some high-risk people lacking opportunity may never commit crime; given enough provocation and/or opportunity, a low-risk, law-abiding person may commit crime. The offender is seen as choosing to commit an offence under particular conditions and circumstances. The decision making is not always fully rational, or even properly considered; instead the perspective emphasizes notions of the limited rationality. The offenders thus are variable in their motives, which may range from desires for money and sex to excitement and thrill seeking. Offenders’ ability to analyze situations and to structure their choice, to switch between substitutable offenses may also vary, as may their specific skills to carry out a crime. (p. 33)

Borrowing from the field of public administration, we can apply Simon’s (1976) notions of “bounded rationality” and “satisficing” to the study of criminality. Bounded rationality assumes that people approach decision making with imperfect and incomplete information and that because it is impossible to make completely rational decisions with this information and we are constrained by time and other obstacles, we stop searching for solutions when we come across one that is good enough; in other words, we are not satisfied with perfect decisions but are satisfied with imperfect ones we think will work.

Apply this to known crime trends (discussed in Chapter 7). For example, most crime is intraclass. Working on a rational offender model, a poor offender committing robbery against a poor victim does not seem to make much sense. Wouldn’t a rational offender want to rob someone with more money? The short answer is yes, and given the opportunity to do so, he probably would. However, it may take more effort to find someone with more money. The robber may also have to travel farther to find a wealthier victim, which further increases the effort required. In addition, if the offender has to travel to an area he is not familiar with, his perceived risk of getting caught also increases. In the end, the meager payout from robbing a poor person, in an area the robber is somewhat close to and familiar with, might in fact be a better deal. It is even possible that an offender’s drug use and need may cause him to feel a sense of urgency, and thus close...
targets with little reward (that can be hit more frequently) could be part of his decision-making process to have enough money to buy the drugs he needs. Thus, recent rational choice perspectives offer a better framework for understanding imperfect decisions in an imperfect and dynamic environment.

In crime mapping and analysis, offender decision making is an important variable and must be understood for analysts to make useful predictions about future criminal offending. For example, using GIS to analyze a series of robberies in and around Phoenix, Arizona, Catalano et al. (2001) included some important assumptions about offender decision making in their model. First, they separated earlier and later crimes in this series based upon the assumption that decisions about where to commit crimes changes as the level of professionalism increases. Second, they only included those potential targets within 3 miles of a freeway (the average plus one standard deviation distance of the past targets’ locations from freeway access), assuming that future decisions about the attractiveness of a target would be similar to past targets. Furthermore, an average daily net (the total score of a robbery divided by the number of days between it and the next robbery) was utilized to make predictions about when the next robbery would occur. Thus, Catalano et al.’s model attempted to make predictions about criminal decision making as to where and when the robbers might strike again.

As you can see, an understanding of criminal decision making is important to the analysis and mapping of crime. The next section takes the notion of rational decision making to the next level by including a discussion of which factors are most important to understanding crimes of opportunity. Specifically, the highest likelihood for crime exists in certain situations where the perceived risk and effort of crime is low and the perceived payout is high.

**Routine Activities Theory**

In Routine Activities Theory, both offenders and victims play a role in the criminal event. In everyday life, people travel back and forth to work, school, play, and home. It is during these normal movements and activities that potential offenders and victims come in contact with one another. Thus, through the normal course of business, people may increase or decrease their risk of victimization based on their patterns. For example, a person who works in an office building Monday through Friday and returns home after work probably has a low chance of becoming a victim of robbery or assault. However, when that same person attends a crowded or rowdy bar or takes part in a volatile
situation (for example, a sports victory celebration that is out of control), the risk of being assaulted or robbed increases. In two recent instances we have seen a pattern of excessive alcohol use (suitable target, motivated offender) combined with the lack of a capable guardian result in the deaths of two young, college-aged women in Aruba (the Natalee Holloway case) and New York City (the Imette St. Guillen case). In addition, patterns of movement and activity have changed dramatically in the last 30 years. For example, many households today require two incomes. Having both guardians removed from the home every day (and removed from neighbors’ homes as well) significantly reduces the offender’s risk of getting caught during a daytime burglary.

The routine activities perspective argues that crime is most likely to occur when the presence of three criteria exist. These criteria include a suitable target, a motivated offender, and the absence of capable guardians (Cohen & Felson, 1979).

Operating on the premise that most crime results from an exploited opportunity, this perspective holds that offenders, rather than engaging in extensive planning, choose to commit crime simply upon meeting an opportunity to do so, and some opportunities are more tempting than others. For example, to examine the suitability of targets for crime, Felson and Clarke (1998) put forth the VIVA risk quotient. VIVA stands for value, inertia, visibility, and access. Essentially, visible targets that are deemed valuable by offenders and are portable and easy to get at are at highest risk. Another useful acronym, CRAVED, (concealable, removable, available, valuable, enjoyable, and disposable) is expanded to include the elements of concealability and disposability (Clarke, 1999). That is, offenders must also be able to hide the item(s) during the commission of a crime and quickly dispose of the stolen items in the black market.

Roman (2005) operationalized several concepts from Routine Activities Theory to examine the spatial and temporal influences on violent crime. In his study of youth crime in Prince George’s County, Maryland, he developed a model of opportunity that incorporated variable clusters measuring (1) place-associated risk, (2) the potential level of guardianship (from Routine Activities Theory), (3) informal social control measures of guardianship (from Social Disorganization Theory), (4) the potential for motivated offenders, and (5) the influence of violent crimes from bordering neighborhoods. Temporal influences were measured by the time of day, day of the week, and the time of year. (All of these were grouped based on the school session, for example, commuting times to and from school, evenings, curfew period, and weekends.) The analysis also included a spatial lag of vio-
lent crimes (computed by using a weighted average of crime rates in neighboring locations). Roman’s findings indicate strong support for Routine Activities Theory and argue for the inclusion of temporal influences in understanding violent crime.

The study results provide strong support for routine activities theory, as well as support for theoretical models that explicitly account for time of day. Individuals are vulnerable to violence during times when the flow of youth is highly concentrated. At certain times of the day there will be places with high concentrations of youth and limited adult supervision. Youth hangouts, schools and busy retail establishments all influence levels of violence, but their impact on violence is mediated by the time of day. For instance, places with youth hangouts generate 40% more crime in the after-school period than during the weekend. In addition, the findings suggest that weekend routine activities may bring about very different types of opportunity for violent crime. (Roman, 2005, p. 306)

Thus, routine activities approaches hold some interesting opportunities for crime mapping and analysis and can help guide strategies for crime control and resource deployment. The inclusion of contextual variables that measure various aspects of routine activities may improve the prediction power of crime maps and analyses, increasing their usefulness.

**Crime Pattern Theory**

Crime Pattern Theory intersects Rational Choice Theory, Routine Activities Theory, and environmental factors to provide a comprehensive explanation of crime (Brantingham & Brantingham, 1981, 1984, 1993). In crime pattern theory, individuals have both activity spaces and awareness spaces. A person’s awareness space is comprised of those areas with which he is familiar. Rossmo et al. state that this is “similar to the concept of a comfort zone” (Rossmo, Laverty, & Moore, 2005, p. 106). An individual’s awareness space is typically (but not always) derived from the individual’s activity space. An activity space is comprised of various nodes of activity or locations that represent where people live, work, and play. The routes people take to travel back and forth from nodes are called paths. These paths are important in calculating the journey-to-crime distances that are discussed in Chapter 4. For now, the importance of these paths to Crime Pattern Theory is that potential offenders tend to search for opportunities to commit crimes along the nodes and paths of their own activity and awareness spaces. In addition to nodes and paths, edges are those areas on the peripheral (both physical and perceptual) of an activity space. These edge areas are premier locations for criminal offending. This is
because the level of diversity encountered here (in people from both sides of the edge and their activities) limits the surveillance capabilities of potential guardians. Figure 3–1 illustrates a simplified model of how a person’s activity space may look.

Of course, depending on how far one travels and how many different nodes and paths an individual has, activity spaces can be vast and complex. Private investigators, for example, are likely to have very large and very complex activity spaces because their job requires them to drive to multiple locations on any given day. Awareness space also consists of places that individuals have visited or are aware of, such as landmarks, relatives’ homes, etc. We also have to consider that some people are very transient and may move around a lot during their lifetime, and thus their awareness space and activity space changes over time.

Crime Pattern Theory provides a framework for understanding both offender and victim behavior patterns. Individuals, including offenders, create cognitive maps of areas they are familiar with while traveling from one node of activity to another. Offenders use these maps to help them choose targets of crime. What we see here can often be that an offender searches directly around them for opportunities to commit crime that are within their own awareness space, or they may also travel to specific locations (bus stations, ATM locations, shopping

![Figure 3–1](image-url)
mall), often called “crime attractors,” and wait for a victim. Through the processes of recognition, prediction, evaluation, and action (Smith & Patterson 1980), cognitive maps are created, targets are chosen, and crime is committed.

Whichever type of hunting one offender or another does may also relate to the obligatory time and discretionary time that they have available. An offender who works will most likely be obligated during his work hours and not be able to commit crime; however, when he gets off work, he can commit crime during this discretionary time. In any case, if the analyst can determine what type of thought processes the offender may be using, he or she can be better at predicting a new hit or determining where the offender may reside (see Chapter 4).

**Lifestyle Exposure Approaches**

Lifestyle exposure approaches to the study of victimization suggest that understanding offender behavior and decision making is only one component to crime and that victim behavior is also important, sometimes more important to understanding a criminal event. The notion of shared responsibility (while this term is not meant to place blame upon victims) implies that both victims and offenders contribute to a criminal event, sometimes in minor and sometimes in major ways. For example, a victim who leaves his car unlocked with the keys in the ignition (which was a common practice in cold weather climates during the winter season prior to the mass production of remote car starters) shares some responsibility in the theft of his automobile. A victim of robbery walking alone in a crime-ridden neighborhood at night shares some responsibility in his victimization. This is not to say that either of these victims deserved to be victimized. What we mean is that the decisions and behaviors of victims can create, in part, more attractive opportunities for motivated offenders. Recognizing this and taking active measures to reduce risks of victimization is the first step in preventing crime.

Karmen (2004) categorizes differential risks of victimization into several dimensions. First, the degree of attractiveness refers to the levels of risk and potential rewards for an offender. Victims who are likely to be carrying large amounts of cash (restaurant employees, for example) may be more attractive to potential robbers than college professors carrying bags full of books. However, the college professor, with her arms full, may be an easier target for sexual assault. Second, proximity refers to the geographic and social closeness an offender has with a potential victim. Targets that are easiest to reach geographically...
and socially are at highest risk. The *deviant place* factor (such as hot spots of crime), for example, allows greater access to victims for a variety of reasons (a large number of potential targets, lack of social efficacy, poor physical design characteristics). *Vulnerability*, a third dimension, has to do with how capable a potential victim or target is to resist being attacked. The college professor previously described would be more at risk as her arms were occupied by heavy bags of books (which could also be used as weapons if she has good upper body strength). Karmen also places victim behavior on a continuum as it relates to shared responsibility in the victimization. *Victim facilitation* refers to victims whose behavior was negligent in making themselves a more attractive or vulnerable target. *Victim precipitation* or *provocation* refers to situations where victims contributed *significantly* to the criminal event. A burglar getting assaulted by an awakened home owner would be an example of precipitation. In the case of provocation, the crime would not have occurred if it was not for the victim’s behavior. An example here might be a pretty college student who dresses provocatively and then goes to a topless bar or strip club “just for the excitement.” Although her intention may not be to be sexually assaulted, she places herself in a place, time, and amongst potential offenders of the crime deliberately.

Along these lines, lifestyle approaches suggest that the reason that victimization risks are higher for some and not others is because of the movements and activities associated with various factors. For example, younger persons in general (under age 25 years) are far more likely to be victims of violent crimes than are persons older than age 25 years. In addition, single persons are more likely to be victims of certain crimes (such as robbery) than married persons. These increased risks are not simply due to age or being married, but they are due to the changes in movement and activities that being older and being married brings. Young and single persons are more likely to be out and about in places or events (parties, concerts, sporting events) that may put them in a higher risk bracket for being victimized.

A person’s profession may also affect his or her risk of certain types of victimization. Police officers, for example, held the highest rate of workplace violence compared to all other occupations studied during the years 1993 to 1999, accounting for 11% of all workplace violence (Denhardt, 2001). Those working in mental health occupations were second in their rates of workplace victimizations. College professors were victimized the least. Persons employed in the transportation (bus and taxi drivers, for example) or retail sales fields were more likely to be victims of robbery. Those employed in the transportation field held
the highest rates of being victimized with a weapon. Persons working in retail sales had slightly higher risks of workplace violence overall than persons in transportation, teaching, and medical fields.

In addition to legitimate activities and movements, nonlegitimate activities can also place some persons at higher risks of victimization. For example, it’s not hard to imagine why prostitutes, drug addicts, and gang members have very high rates of victimization compared to the rest of the population.

Repeat victimization (similar to repeat offending) can be explained in several ways. First, risk heterogeneity suggests that the characteristics of targets, or places that made them attractive to offenders in their first victimization, were also attractive to other offenders in subsequent victimizations (Gill & Pease, 1998). For example, an openly gay man practicing homosexual behavior in an atmosphere inhospitable to homosexuals may become a target for victimization. Continuing this behavior on subsequent evenings in the same atmosphere may make this person a target for future victimizations by the same types of offenders. Event dependency explains that an offender chooses to revictimize a person or place based on their successful past experiences. Places where offenders successfully committed crimes are attractive places for repeat performances. For example, it is not uncommon for a liquor store to be robbed several times by the same offender. Consider also the repeated victimization of individual citizens and shop owners by organized criminal enterprises offering protection from other thugs and troublemakers. Last, virtual repeats are when similar targets are chosen based on their similarities to past targets (Pease, 1998). For example, grocery or convenience stores with similar layouts may be hit in a robbery series.

Lifestyle approaches and explanations of repeat victimization help us understand why some people and places are victimized at greater frequency than others. They also provide valuable cues to crime analysts and mappers about which people and places are at highest risk of being victimized, allowing law enforcement officials to implement proactive measures aimed at reducing and preventing crime. Sometimes, however, in discouraging offenders from committing crimes against specific persons and places, we may encourage them to perpetrate their crimes elsewhere.

## Displacement and Diffusion

Some research suggests that many crime intervention efforts do not reduce crime but simply displace it (Repetto, 1976; Clarke & Weisburd, 1994; Barnes, 1995; Clarke, 1998). There are two general kinds of
crime displacement: benign and malign (Barr & Pease, 1990). Benign displacement is viewed as a success in that while criminals have not been prevented from committing crime altogether, they have at least been displaced to committing crimes that are less harmful or serious in nature. Malign displacement, on the other hand, is when criminals begin to commit crimes that are more serious and/or harmful due to the continued successful thwarting of their previous efforts. When evaluating the success of a crime control strategy, crime analysts must make maps and perform analyses to check for displacement, examining changes in different types of crime and changes in neighborhoods beyond the area targeted by the intervention(s) to ensure that crime was truly reduced and not simply displaced.

Types of Displacement

Repetto (1976) identified five types of displacement. Spatial or territorial displacement occurs when crime is moved from one place to the next. This is often thought to be the most common type of displacement. However, research is mixed concerning the amount of territorial displacement that occurs. Santiago (1998) found that efforts to reduce auto thefts in Newark, New Jersey displaced the crime to adjacent areas. Canter (1998) also observed displacement of residential burglaries occurring in Baltimore. Chainey (2000) found that the use of CCTV was effective in reducing both street robbery and auto theft but that some displacement of the auto thefts occurred in surrounding areas. Displacement of street robbery, however, did not occur.

Temporal displacement occurs when crime is moved from one time to another but stays within the same area. This could mean that an offender or offenders move from operating on a weekend day to a week day or from early morning to late afternoon. This is important to understand, especially in a series analysis where patterns of offending may change to mitigate risks of getting caught.

Target displacement occurs when criminals choose another target due to target hardening and other strategies to reduce crime. Target hardening measures, such as house alarms or dogs, may displace a burglar to a different house in the same neighborhood without such protection measures. Tactical displacement is when criminals develop new methods to commit the same crime. For example, automobiles are much more difficult to steal today than they were 15 or 20 years ago. It is theorized that the rise in carjackings that occurred in the 1990s was due to the increased difficulty of stealing unattended vehicles that were armed with sophisticated alarm systems and other devices. While carjacking is technically a new crime, the offender’s goal of stealing an
automobile remains the same. The methods, however, have changed. In carjacking, the offender takes (or attempts to take) a motor vehicle by force or the threat of force. This is a perfect example of malign displacement, where crime prevention efforts (target hardening of automobiles) created a change in tactics (and also in this example, a change of crime) that is more harmful and serious in nature than the original crime of auto theft.

Functional displacement occurs when the offender has difficulty committing one crime due to target hardening strategies and is forced to commit a different crime. The previous example of carjacking also works as an example of functional displacement because carjacking is a separate crime from auto theft. Another example would be a burglar switching to armed robbery due to the increased target hardening efforts, such as the installation of alarms by property owners.

The final type of displacement, offered by Barr and Pease (1990), is perpetrator displacement. Perpetrator displacement is most common in drug manufacturing and distribution crimes. For example, law enforcement efforts may cause a drug dealer to desist from further drug dealing (perhaps he was arrested and is in jail). However, in the drug market, these efforts create a vacant position for another drug dealer to step in and take his place. Thus, we have traded one drug dealer for another.

**Diffusion of Benefits**

Now that we have made you skeptical about whether or not crime prevention is ever truly achieved because of crime displacement, let us discuss another possible effect of crime prevention efforts (a much more positive one), the diffusion of benefits. The diffusion of benefits is defined as “the spread of the beneficial influence of an intervention beyond the places which are directly targeted, the individuals who are the subject of control, the crimes which are the focus of intervention or the time periods in which an intervention is bought” (Clarke & Weisburd, 1994, p. 169). Clark and Weisburd argue that two possible sources for diffusion exist: deterrence and discouragement. For example, imagine that your local police department has announced through the media that they will be targeting shoplifters at various local stores throughout the summer months. Potential offenders may be deterred from shoplifting at stores that are not identified in the announcement for fear that they are too close in location to the stores that will receive the enhanced enforcement. Likewise, it is possible that offenders will wait until late fall to return to the stores to shoplift, fearing that stepped-up enforcement may persist until sometime in
September. This buffer of space or time provides the benefit of crime prevention efforts without actually engaging in them. Offenders are discouraged from shoplifting at the stores during these times because their perceived risk has been increased by the enhanced enforcement. What are often seen in typical police departments are enforcement activity areas, or what could be referred to as selective enforcement areas. These are small geographic sections of town that have been designated for extra patrols, increased offender apprehension, or other crime prevention programs. Depending on the effectiveness of the increased enforcement in this small geographic area, we may see beneficial diffusion results not only within the small area but surrounding it as well.

**Conclusion**

In conclusion, crime and victimization are not evenly distributed across people or places. Several approaches to the study of victimology suggest that understanding the targets, or victims of crime, that make them more attractive to offenders can provide valuable information to the examination and study of crime. Knowing which places or people are most likely to become victims of crime allows us to make better predictions about where and when crime is most likely to occur and better informs the mapmaking and crime analysis process—a critical part of preventing and reducing crime. The next chapter continues our discussion of the environment and decision making and examines the theory and research on serial offenders.

**Questions for Review**

1. How is environmental design used to reduce or prevent crime? What crime prevention strategies utilize environmental design elements?
2. What are the four key elements to Newman’s *defensible space*? Explain each briefly.
3. How do public, semipublic, and semiprivate spaces differ? Give an example of each.
4. Explain how designation, definition, and design are used to assess space in crime prevention efforts.
5. What factors are included in offender decision-making models by modern day rational choice theorists?
6. According to Routine Activities Theory, crime is most likely to occur when three criteria exist. Briefly explain these three criteria.
and provide an example of a scenario where crime is most likely to occur.

7. How do VIVA and CRAVED explain offender decision making and opportunity? Based on these models, which items are most likely going to be stolen from a motor vehicle? Which items would be least likely to be stolen from a motor vehicle?

8. Explain the concepts nodes, pathways, and edges in Crime Pattern Theory. How does Crime Pattern Theory explain both offender and victim behavior? Draw a map of your own activity space.

9. According to Karmen, what are the differential risks of victimization?

10. In what ways do victims contribute to their own victimization?

11. Explain risk heterogeneity, event dependency, and virtual repeats. Provide an example of each.

12. What is the difference between malignant and benign displacement?


**Chapter Glossary**

**Activity Space**  In Crime Pattern Theory, activity space denotes the areas that offenders and victims are most familiar with on a daily basis. It contains nodes (home, work, school) and pathways (how people travel to and from their nodes on a daily basis), which define the borders (edges) of the space where people live, work, and play.

**Awareness Space**  In Crime Pattern Theory, typically a broader area than activity space. Awareness space includes any area that an offender is familiar with.

**CPTED**  Acronym for Crime Prevention Through Environmental Design. Attributed to Jefferey (1971), this approach examines the environment as a stimulus that potential offenders and victims respond to. Essentially, CPTED argues that we can reduce crime opportunities by changing the physical environment.

**Crime Displacement**  When offenders change their offending patterns in response to crime control strategies, crime displacement occurs. There are six types of crime displacement: territorial, functional, tactical, temporal, perpetrator, and target.

**Defensible Space**  Newman (1972) argued that areas with defensible space are less likely to suffer from high crime rates. Areas with defensible space could be characterized as having high levels of territoriality, natural surveillance, image, and milieu.
**Diffusion of Benefits**  The benefits of a crime control strategy extend beyond the borders where the strategy is employed.

**Event Dependency**  Situations where the same offender (usually) commits the same offense against the same target or victims.

**Hedonism**  The principle that people act to pursue pleasure and avoid pain.

**Risk Heterogeneity**  Something about the victim or target is attractive to different offenders and are thus more likely to be victimized multiple times.

**Victim Facilitation**  Victim facilitation is when victims, whether carelessly or unknowingly, make it easier for an offender to commit a crime against them.

**Victim Precipitation**  Victims who are hurt significantly in a crime in some way, usually violence related, contributed to the outbreak of the violence.

**Victim Provocation**  Victims who are actually responsible for their own victimization.

**Virtual Repeats**  When similar targets or locations are being victimized, usually by the same offender(s); for example, a robbery series of a chain of video stores.

### Chapter Exercises

#### Exercise 5a: Selecting Features Part I

**Data Needed for This Exercise**
- All data is already contained in EX5.mxd.

**Lesson Objectives**
- In this exercise we will learn how to select features on our map interactively using the Select tool.

**Task Description**
- There are many ways to select data in ArcMap to get the result that we need when we need it. This exercise will cover the Interactive Select tool and the different ways in which data can be selected and then used when it has been selected.
- The Foothills patrol commander has requested a map showing only the Foothills patrol division, beats, grids, and streets. Because we do not have individual patrol division shapefiles, we will need to create them using the Select tool in ArcMap and then create new shapefiles for just that division.
1. Open EX5.mxd.
2. You should see a map of the patrol division boundaries for the entire city along with some main streets and grids showing.
3. We will first select only the Foothills division with the Interactive Select tool (select features) in the Standard toolbar.
4. Click at the bottom of the TOC on the tab that reads, Selection.
5. Uncheck all the themes except for the Patrol Divisions theme.
6. Using the Select tool, click in the middle of the Foothills division (northernmost patrol division) and watch as light blue select lines show up around the polygon. (If you don’t remember where the Foothills division is, turn on the label features by right clicking the Patrol Divisions theme to identify it.)
7. Now we want to make a brand new shapefile from this selected polygon.
8. At the bottom of the TOC, click on the Display tab to return to the regular legend.
9. Right click on the Patrol Division theme, and choose Data → Export Data
10. Make sure that the top box says Selected Features.
11. Save this file in your student directory as FHDivision.shp.
12. Answer Yes to adding it to the current map project, and then turn it off after you have verified that it is only one polygon of the Foothills division.
13. Go up to Selection in the menu bar and choose Clear Selected Features.
14. We need to create a new data frame to hold all of the new shapefiles we are going to create in this project. Creating a new data frame allows us to have more than one map section and store data to specific projects within the project.
15. Click on Insert in the menu bar and then Data Frame.
16. Drag and drop the FHDivision.shp theme to this new data frame and delete the one under the Citywide data frame.
17. When you created the new data frame, it automatically became the active frame.
18. Right click on the citywide data frame and choose Activate.
19. By repeating this process with each data frame, you can browse the data in each one as needed.
20. Right click the data frame called New Data Frame and go to Properties.
21. Under the General tab, rename this data frame to say Foothills.
22. Click Apply and then OK.
23. Save your project as EX5.mxd in your student folder.
24. Make the citywide data frame the active data frame again.
25. Now go to the Selection tab at the bottom of the TOC and make the Beat layer the only selectable theme.
26. Turn on the beats in the TOC so that they are visible.
27. Make sure the Select Features tool is the current tool on the Standard toolbar.
28. Go up to the upper left corner of the Foothills division beats and click and hold the left mouse button down while you drag to the lower right side of the beats.
29. Let go of the mouse, and now all of the beats in the Foothills division should be selected. An alternative way to do this is to click on the first beat, then hold the shift key down and select the other beats until each one has been selected.
30. If any beats in Gateway division are selected by accident, simply hold the shift key down and click on the beats to unselect them. Keep doing this as needed so that only the beats in the Foothills division are selected (they should have a blue line around them).
31. Export these beats as FHBEATS.shp in your student folder, and add it back to the Foothills data frame as we did with the Foothills division boundaries. Make sure to choose Yes to make a new layer.
32. Clear the selected features and make the Foothills data frame the active theme.
33. Right click on the FHDivisions.shp theme and choose Properties.
34. Go to the Symbology tab.
35. At the top right is a button labeled Import.
36. The Import Symbology dialog menu will appear, and we want to point to the Patrol_Divisions layer for our symbols (see DVD Figure 5–1). Click OK and then OK again, and accept Regions as the legend item value.
37. In the Symbology window, click on the Gateway value, and click on the Remove button to get rid of that legend item because we don’t need it anymore.
38. Click **Apply** and **OK** to return to the map. Make sure that beats and the division are turned on in the Foothills data frame (see DVD Figure 5–2).

39. Do the same thing for the beats; however, use the Beats theme as the layer source for our legend items.

40. You will need to remove the legend symbology for beats 30–37 and then **Apply** the legend.

41. Repeat the entire process we went through for the patrol division with the Grid and Beats layers. Make sure you
   - make only the Grid layer theme selectable first
   - do your selections and exports
   and then make only the Beats theme selectable
   and repeat the process.

42. For the Main Street theme we could interactively select every single street, but because we still have all the grids selected in the citywide data frame, we can use these selected records to clip the city streets and create a new shapefile of those main streets that intersect the selected grids in the Foothills Patrol Division.

43. Click the little red toolbox to open the ArcToolbox functions.

44. Click on **Analysis** tools and then find **Clip**.

45. Double click **Clip** to open the Clip menu.

46. Complete the dialog menu as follows:

   - **Input Feature**: `City_Main_Streets`
   - **Clip Feature**: `Grids`
   - **Output Feature Class**: Save as `FHMainSt.shp` in your student folder (see DVD Figure 5–3)

47. Click the **OK** button.

48. If the Clip dialog menu did not close after it completed, close it now.

49. The new theme has been added to the citywide data frame. Drag and drop it into the Foothills data frame, and turn it on after making that data frame active.

50. Close the ArcToolbox.

51. We are seeing every single street and not just the main streets, right? Why do you think this is?__________________________

52. The legend for `City_Main_Streets` was controlling the street segments we could see, but all of the street segments were actually still in the attribute table because a legend only tells ArcMap what
information to display and in what manner. It does not alter the underlying data.

53. As we did for the other themes, import the legend from the City_Main_Streets for our new theme and watch the magic.

54. Save your project and exit ArcMap.

Exercise 5b: Selecting Features Part II

Data Needed for This Exercise
• All data is already contained in EX5b.mxd.

Lesson Objectives
• In this exercise we will learn how to select features on our map based on attribute information within the tables behind our graphics on the map.

Task Description
• The Select By Attributes function allows us to select information from a theme’s attribute table through a SQL query.
• In this exercise, the chief has requested that you display a map of the gang members in the following two gangs:
  • Homeboys
  • Southside Glendale Locos
• We will learn how to create a temporary layer file from our selection and use the Create New selection, add to selection, and the select from selection features to get what we need.
• A gang crimes detective has an aggravated assault case where the nickname of “Clown,” or “Payaso” in Spanish, is used. He believes that the suspect belongs to the Crip Locos gang, but he is not positive. He also knows that the witness described the suspect as a Hispanic male (H/M), 25 years old, 5’10″, and 140 lbs.

1. Open EX5b.mxd.
2. You will see a citywide map with the Gang_Members theme at the top of the TOC. It is turned on, showing where all these imaginary miscreants of society reside.
3. Click on the Selection menu item and choose Clear Selected Features to begin. This makes sure that if any features are selected, they are all cleared before we begin. If this item is grayed out, then there are no selections in any of the themes.
4. Go to Selection ➔ Set Selectable Layers and make sure that only the Gang_Members layer has a check mark next to it.
5. Go back to the Selection menu item and now choose **Select by Attributes**.
6. In the Select by Attributes dialog menu, enter the following formula to select just the Homeboys members.
   
   “GANG_NAME” = ‘HOMEBOYS’

7. Make sure you click the **Verify** button before running the SQL code to make sure there are no errors in your code (see DVD Figure 5–4).
8. After you click **Apply** or **OK**, you will see that several points are now highlighted on the map. These are all the Homeboy gang members. We want to save this selection temporarily in this project by creating a layer file of these selected records. Right click the Gang_Members theme and choose **Selection → Create Layer from Selected Features**.
9. Turn off the Gang Member theme and see that the Gang Member selection layer only has the Homeboys gang members included.
10. Right click this new layer, go to **Properties → General** and rename this temporary layer to **Homeboys**.
11. Change the symbology for the Homeboys layer to a red triangle at 8 points in size.
12. Repeat this process for the Southside Glendale Locos gang members.
13. Remember to make sure only the Gang_Members theme is the only selectable layer and that you have cleared all previous selections before you begin.
14. Make sure to set the new theme name to “Southside Glendale Locos,” and change the symbol to a blue triangle or other symbol as desired.
15. Now by turning on and off these two temporary layers, you can create two maps, one for each gang member list, for the chief.
16. The gang detective is looking for a subject nicknamed Payaso or Clown, and the witness described the suspect as being a Hispanic male, 25 years old, 5’10”, and 140 lbs. It is possible that he belongs to the Crip Locos gang, but the detective is not positive of this.
17. We can begin this search for our gang member in several ways. We could be very specific and find just those Crip Locos who meet the physical description and then find those with similar nicknames, or we could find everyone with the nickname and then those that meet the general description.
The general rule of thumb is to start your search with the item that will give you the most records and keep whittling down the data by adding additional search criteria until you’ve found what you want.

We will start with the simplest search that will give us the most records.

Go to Selection → Select by Attributes and enter the following formula in the SL query window:

“RACE” = ‘H’ AND “SEX” = ‘M’

Make sure you verify the query and then press OK to run it.

You will see that a whole lot of the points are highlighted, and very few are not selected.

Let’s refine this search by adding some additional query criteria to the selected records.

Go to Selection → Select by Attributes again, and this time in the Method box change it from Create a new selection to Select from current selection. This will only query the records that are already selected.

Notice that the previous search criterion is still in the SQL query window. This will usually stay there unless you close this session of ArcMap or replace it with a new query string.

Replace the previous query string with the following:

“NICKNAME_A” = ’CLOWN’ OR “NICKNAME_A” = ’PAYASO’

Click OK, and now you should see only three or so records highlighted in the map.

Open the attribute table for Gang Members, and then click the Selected button at the bottom of the attribute table window.

Now you are seeing only those three selected records. Browse the data and see which subject might be the offender the detective is looking for.

None of these gang members belong to the Crips, but that was just a possible item anyway.

We can check to see if there are any Crips gang sets that may have a nickname like Payaso by adding some search criteria to this current query.

With the attribute table open, click on the Options button, choose Select by Attributes, and set the method box to Add to Current Selection.
33. Add a new SQL query that reads:
   
   
   ```
   (“NICKNAME_A” LIKE '%CLO%' OR “NICKNAME_A” LIKE '%PAY%’) AND “GANG_NAME” LIKE '%CRIP%'
   ```

34. Make sure to click **Verify** to make sure your query contains no errors. If you receive an error message, check to make sure you have the correct spacing, number of characters, and that you have the parenthesis correct as shown. You should have added one record to the selected records and now have four records.

35. The newest addition happens to be a black male with the nickname of Clown and also belongs to the Crips Locos gang. You would normally provide this information to the detective by printing it out in an organized format.

36. Save and close the project in your student folder.

**Exercise 5c: Selecting Features Part III**

**Data Needed for This Exercise**

- All data is already contained in EX5c.mxd.

**Lesson Objectives**

- In this exercise we will learn how to select features on our map based on where they are located near other geographic areas or within polygons of our choosing.

**Task Description**

- This exercise will flex those select muscles and help you to manage your searches for data and information inside ArcMap.
- There will be three tasks we need to accomplish for this exercise that all involve a tactical prediction for a robbery series in which we have already determined the most likely hit location and point around which the suspect most likely lives. Using our ability to search by location and search by attributes together, we will find a robbery suspect from existing data and also figure out which store the offender will most likely hit next. This will enable us to provide good information to investigations that are based on our analysis.

1. Open EX5c.mxd.
2. You will see a project that is zoomed into an area of town where the video bandit robbery series has been committed. The standard deviation ellipse prediction and the mean center of the crimes are shown along with each of the robberies in the series.
3. We also see a theme for adult probationers, and Glendale_persons (which includes all persons listed in police reports in Glendale.)
We have two basic objectives for this crime series now that we have predicted the general area where the offender may live and the general area where the next crime in the series may occur.

4. Find suspects from available data sources of persons that live near the mean center of the crime series.

5. Find potential next targets in the series.

We will use the VideoSDE2 theme as a cookie cutter to select all of the businesses that fall within its boundaries. We will then use the Select by Attributes query we learned in exercise 5b to limit our results to just video stores.

6. Go to Selection in the menu bar and choose Select by Location. The Select by Location dialog menu will appear, and you will make the following settings (see DVD Figure 5–5):

I want to: Select features from
The following layer(s): Check businesses only
That: Are completely within
The features of this layer: VideoSDE2

7. Click OK.

8. Turn on the Businesses theme and see that only those businesses greater than one standard deviation and less than two standard deviation ellipses areas are now selected.

9. Open the attribute table for the businesses theme.

10. Click the Options button.

11. Choose Select by Attributes from the pop-up menu.

12. Choose Select from Current Selection as the method type.

13. Enter the following formula in the SQL query window:

   "BUSNAME" LIKE '%VID%'

14. Click the Apply button to run this refinement search.

15. Notice that the initial 200 and some businesses have been reduced to 18 records, all of which are video stores or have “video” in their names.

16. While the attribute table is still open, click on the Options Button and then Export.

17. Name the file PossibleTargets.dbf and save it to your student folder.

18. We want to make sure we are saving only the selected records (top box).

19. Minimize ArcMap, open Excel, and load the PossibleTargets.dbf file you just saved. We would generally trim this data and make it
pretty for the detectives and either provide it to them in our bulletin (name and address of each business) or print it and hand it to them as needed so they would know which targets to stake out and wait for the bad guy. We will not do that now, but remember that you can for the future and probably should.

20. There is an extreme amount of versatility you have with combining the Select by Location and Select by Attributes searches. The only limitation is your logic, planning, and knowledge of the data you are working with. There are very few questions that GIS cannot answer if you plan out your project and searches to suit the analysis you are performing.

21. You could also right click the Business theme while these records are selected and then go to Data \ Export and save as a new shapefile that we could use in our map for the bulletin. You could also use the Selection \ Create layer from the selected records function we learned in a previous lesson to show just those records on the map.

22. Our next endeavor is to try to find a potential suspect from the basic suspect description we have for each robbery and the information on persons we have available to us. Turn off the Businesses theme and clear all selected features.

23. Turn off the VideoSeries and VideoSDE2 themes, leaving the Video MeanCtr theme on.

24. The offender has traveled about 2.2 miles between each hit (use the Measure tool to get the total distance and divide by five robberies).

25. We can also use the Measure tool to find the average distance from the mean center for each robbery. We find that:

- Mean center to first robbery ≈ 1.29 miles
- Mean center to second robbery ≈ 1.69 miles
- Mean center to third robbery ≈ 2.58 miles
- Mean center to fourth robbery ≈ 0.99 miles
- Mean center to fifth robbery ≈ 0.86 miles

The average distance from the mean center is approximately ≈ 1.48 miles.

26. This means that the offender may travel about that far from the mean center again about 50% of the time. It also means that there is a good chance that the offender in this series lives very near to the mean center of the crimes.
27. Turn on the Adult Probationers and the Glendale Persons themes to see how many people we need to get rid of in our search. It seems daunting, doesn't it? However, with some logical expressions and some thought, we can whittle this list down to a manageable size for the detectives in this case.

28. You can turn those themes off now to save the time it takes to draw them all.

29. Go to Selection ⇒ Select by Location again (see DVD Figure 5–6).

30. In this dialog menu, enter the following values:
   - Select features from: Adult_Probationers and Glendale_Persons
   - Are within a distance of: VideoMeanCtr
   - Check the box next to Apply a Buffer to the Features in VideoMeanCtr and set the distance to 1.48 miles

31. Click OK to run the search.

32. The search will take quite a long time to run because it will search several thousand records in these two themes.

33. Turn these two themes on and off to see that only a circle of records around the mean center were selected. You should also recognize that there are 588 adult probationers selected and over 28,000 persons selected in these two themes. Going to the detectives with this many possible suspects doesn’t make much sense, does it?

34. The suspect description in our robbery series is: white male, 25–40 years old, 130–150 lbs, black hair, brown or hazel eyes, and one witness thinks he saw a tattoo on one hand with the word “Cry” in it. Another witness saw a tattoo on his left arm that looked like “Vanessa.” In one robbery the victim told police that he thought someone had been waiting outside for the suspect and acting as a lookout, but he was not sure. In at least two of the other robberies, the victims felt that the offender left in a getaway car that was driven by another white male.

35. Now that we have found all the potential offenders that live within the potential anchor point locations, we can trim the choices down by using a Select by Attributes query on each theme.

36. Open the attribute table for the adult probationers and make sure you do not click anywhere on the rows of data. Doing so will unselect all of the records and only select the record you clicked on. To avoid errors, keep your finger off of the left mouse button while browsing the data in the tables with records selected.
37. Click on the **Selected** button to show only those selected records.

38. Click on **Options** → **Select by Attributes** to bring up our old pal.

39. Make sure the method is set to **Select from Current Selection**.

40. Enter the following SQL code in the window:

   \[
   \text{[ETHNIC]} = ‘W’ \text{ AND } \text{[GENDER]} = ‘M’
   \]

41. Verify the query, and then click **Apply** to run it.

42. This whittles your list down to 176 records.

43. Enter a new SQL code query as follows, but leave everything else the same on the Select by Attributes dialog menu:

   \[
   \text{[HEIGHTFT]} = 5
   \]

44. Apply this new search limiter.

45. We now have 116 records.

46. Enter a new SQL query, leaving the other settings alone, and changing the SQL to the following:

   \[
   \text{[WEIGHT]} \geq 130 \text{ AND } \text{[WEIGHT]} \leq 150
   \]

47. Apply it and see that your total records reduce to 38.

48. This data has no Age field, and only some date of birth (DOB) fields have data entered. (The DOB field has values in a text field in the yyyymmd format; e.g., “19721010,” or the DOB is missing or null). Because we cannot use this tex format and DOB data very easily to give us a possible age range, let’s try searching for the “Cry” tattoo instead.

49. Because we don’t know what other text may be in the tattoo, we need to use the Like operator as follows:

   \[
   \text{[SCAR1]} \text{ LIKE}’*CRY*’ \text{ OR } \text{[SCAR2]} \text{ LIKE}’*CRY*’
   \]

   **Note:** The wildcard character changes depending on if we are working with a shapefile (%), a personal geodatabase file (*), a file geodatabase(%) or an SDE layer(%). For more information, query the ArcGIS Help for “wildcard.”

50. Apply this new search to reduce our search down to three records:

   - Michael Brown
   - Michael Contreras
   - Frank Crittenden
51. Only Frank’s record shows that he has black hair, but they apparently each have similar tattoos that are worded slightly differently in the probation data.

52. The Descr field shows that the two Michaels are on probation for drug violations, and Frank is on probation for aggravated assault.

53. In real life we would export these records to a new Excel spreadsheet and add the information to our bulletin, but let’s just move on to the Glendale Persons data and whittle it down the same way.

54. Turn off the Adult Probationers layer, turn on the Glendale persons layer, and open its attribute table. Work out how to make similar queries on this layer for a possible suspect. Remember, we only want those persons within 1.48 miles of our mean center. If this selection does not already appear, you will need to perform a Select by Location query using the directions in steps 29–31 above.

55. Possible query steps could include:
   - [MARKS] LIKE ‘CRY’
   - [RACE] = ‘W’ AND [SEX] = ‘M’
   - [HEIGHT] >= 504 AND [HEIGHT] <= 508
   - [WEIGHT] >= 130 AND [WEIGHT] <= 150

56. You should wind up with about eight records or so, depending on what order you applied each of these search criteria.

57. Three of the eight records will have a tattoo description with “Crystal” instead of “Cry” in it, but five good records are returned.

58. We also may have forgotten that another tattoo might have begun with “Vanessa,” so we can add records back into the selection by using the same Select by Attributes query and changing the method to Add to Current Selection.

59. We wind up with 129 records. (You should get 129 records if you did what I did. If your query was done in a different order, you may get more or less records.) However, looking at the map display shows that they are all over Glendale and not just within the 1.48 miles of the mean center.

60. Keep in mind that one search parameter overwrites the other search parameter and that generally we use the location search first and then attribute queries to whittle down the list. Doing it in the wrong order can cause you to go back to the beginning and start all over. We can continue to reduce this new list of 129 records by repeating the other queries for race, sex, height, and weight. Remember to change the method back to Select from Current Selection before you begin, and see how many records you can refine the list to.
61. You should be able to get back down to about 8–18 records, depending on your review of the records and information. By modifying the SQL query to [MARKS] LIKE '*cry*' and including a space after the “y” in “Cry,” you can avoid getting back records for persons that have “Crystal” tattoos and information as well.

62. Save and close your project to your student folder as EX5c.mxd.

Exercise 5d: Selecting Features Part IV

Data Needed for This Exercise
- All data is already contained in EX5d.mxd.

Lesson Objectives
- In this exercise we will learn how to select features on our map based on where they are located within a graphic polygon we will draw and use to make our search.

Task Description
- This exercise will continue to flex those select muscles with a new tool called Select by Graphics.
- A patrol commander has come to you and indicated that he needs some quick numbers on calls for service for a focus area that they have been working for a few months. He indicates that the area is bounded by Camelback Rd on the south, Maryland Av on the north, 57th Av on the east, and 63rd Av on the west.
- You will need to draw a polygon that generally fits this area and then use it to select calls for service that intersect this graphic polygon. You will learn how to summarize data from a single field in an attribute table for selected records.

1. Open EX5d.mxd.
2. You should only see three themes in the TOC.
3. We will use the Select by Attributes search to find the streets that bound our focus area.
4. Choose Selection → Select by Attributes.
5. You will choose the City_Main_Streets as the layer to search on, and enter the following SQL query in the window (see DVD Figure 5–7).

\[
[\text{ANNAME}] = 'N\ 57TH\ AVE' \ OR \\
[\text{ANNAME}] = 'N\ 63RD\ AVE' \ OR \\
[\text{ANNAME}] = 'W\ CAMELBACK\ RD' \ OR \\
[\text{ANNAME}] = 'W\ MARYLAND\ AVE'
\]

6. Click OK to apply the search.
7. You should see something like the following in the map display (see DVD Figure 5–8) after applying this search query.

8. Zoom into the extents of the box that is formed by the selected streets.

9. Go to View → Toolbars and make sure that the Draw toolbar is turned on. If you are turning it on now, drag and drop it at the bottom of the project window (see DVD Figure 5–9).

10. The Draw toolbar has several functions, but for now we are just going to use the polygon Draw tool, which is the tool at the top center of the pop-up menu when you click the small down arrow next to the fifth item from the left in the toolbar (see DVD Figure 5–10).

11. Think of this tool as if you are stretching a rubber band over some anchor stakes at the corners of each point where the streets we want to follow change direction. Select the New Polygon tool and then click at the upper left corner of our selected streets. Make sure you have zoomed in as far as you can so that the placement of the boundaries you create will be semiaccurate.

12. Click at each place where the selected streets seem to change direction slightly, and follow the curve of the streets as best as you can. Clicking once at each location where you want to place an anchor (secures the polygon’s boundary line there). When you are back up to the upper right corner of our focus area and in line with the first point we made to anchor our polygon, then double click to create the polygon.

13. You will end up with a polygon graphic that generally follows the selected streets and makes the box that we can use as a cookie cutter to select the calls for service that intersect this graphic (see DVD Figure 5–11). Notice in the image that there are small handles around the graphic. This means that the graphic is selected, and we want it to be selected for the next step. If you have accidentally unselected it, just find the Standard toolbar, make the black arrow your current tool, and then click along the edge of the graphic to get the handles back.

14. Turn on the Calls for Service theme in the TOC and then go to Selection → Select by Graphics, which should now be available because our graphic polygon is selected on our map display.

15. By simply selecting the Select by Graphics search option, the search goes out and selects all the calls for service that intersect it. This can take a while because there are several thousand records to search through.
16. Open the attribute table of the Calls for Service theme and click the Selected button again to show the selected records.

17. Notice that over 22,000 records are selected.

18. Scroll to the right of the table and find the field named Recvdate. Notice that it is in the format of yyyyMMdd.

19. Right click on the field name once and choose Sort Descending. Do this again, but choose Sort Ascending. You should have observed that the data range for these records goes from 20010101 to 20041216 (January 1, 2001 through December 16, 2004).

20. The commander wants a summary table for just that data that was reported to police between July 1, 2004 and September 30, 2004, which were the dates of his action plan efforts. We therefore need to whittle this data down a bit with our old friend the Select by Attributes query.

21. Click on Options → Select by Attributes.

22. Select from the current selection and enter the SQL query of:

\[ \text{[RECVDATE]} \geq 20040701 \text{ AND [RECVDATE]} \leq 20040930 \]

23. Click Apply, and then close the Select by Attributes menu.

24. You should now have around 2997 records instead of 22,000.

25. Scroll to the left (remember not to click on any records inside the table) and find the field called Radioname. Right click this field name to bring up the pop-up menu (see DVD Figure 5–12).

26. Choose Summarize from the choices.

27. Save the summary table as CFSSUM.dbf in your student folder, and click OK.

28. Answer Yes to adding it to the current map project.

29. The TOC was automatically switched to the Source tab, and you will need to expand the folder name where your student files are located. When you do, you will find the CFSSUM.dbf table we created. Open it.

30. Right click on the Count_RadioName field and choose Sort Descending.

31. You now have a list and count of all the calls for service that occurred in this area between July and September 2004 for the commander.

32. In most cases we would then doctor it up to look pretty and professional in Excel before we give it to him.

33. Save your project as EX5d.mxd in your student folder and exit ArcMap.
Exercise 6: Buffers

Data Needed for This Exercise

- C:\CIA\GIS_Data\Boundaries\GLENDALE_CITY_BOUNDARIES.lyr
- C:\CIA\GIS_Data\Streets_Transportation\GLN_SURROUNDING_STREETS.lyr
- C:\CIA\GIS_Data\Other\GLN_City_Parks.lyr
- C:\CIA\GIS_Data\Schools\Area_Schools.lyr
- C:\CIA\GIS_Data\Other\Glendale_Bike_Routes.lyr
- C:\CIA\GIS_Data\Offenses\Offense_data.shp

Lesson Objectives

- Learn how to use the various buffer tools in ArcMap.
- Customize the ArcMap interface to add buttons for useful tools.

Task Description

- When you arrived at the office this morning, you had four e-mails from different people within the police department asking for data from the crime analysis unit.
- Task 1: The motor sergeant wants to know how many DUI offenses/arrests were made “along” Bell Rd in 2003 and 2004.
- Task 2: The chief’s secretary has forwarded an e-mail asking you to report on the number of auto theft cases “around” Bonsall Park in the past year (2004). The chief is not concerned with the park itself, although data from the park would be nice as well.
- Task 3: A school resource officer (SRO) at the Glendale High School is trying to do some problem solving and believes that kids walking home from school between 1400 hrs and 1600 hrs are committing vandalism on the homes “near” the school, and he wants to see how much of a problem it really is. He is not sure if they are doing it in the morning between 0700 and 0800 hours, but he believes the problem is worse in the afternoon. He needs you to advise him on “statistics” for the area.
- Task 4: A city council person has advised the chief that his neighbors have indicated that the bike paths “near” his home are attracting sexual deviants who are exposing themselves to people on the bike paths. He also feels like the number of robberies along the bike path has increased over the last 3 years. The council person lives at 5230 W Hearn and indicates it is the bike path north of his home that runs east and west and not the bike path that runs north and south.
1. Start this exercise by opening ArcMap by any method you prefer and add the six layers needed for this exercise. If you have any difficulties doing this step, EX6.mxd in the Exercise_6 folder has been created for you to use.

2. After adding these layers, make sure that you have all six layers in the project, and save your project as EX6.mxd in your student folder.

3. Remember to save often during the course of your analysis to avoid losing any work.

Task 1: DUI Offenses

1. We will begin with task 1. To fully understand how to complete this task, we have to know what data is available to us and where we can find it. Open the attribute table for the Offense data and browse through the fields to get an idea of what each field has in it and the format of the data. Generally speaking, if the field is left justified it will be text, if it is right justified it will be a number field. Notice also that these are offenses and not individual police reports. This means that multiple offenses could be listed for one report number in our data.

2. Close the attribute table, right click the Offenses theme, and go to Properties.

3. Click on the Fields tab to see the format of each field in the table, its length, etc.

4. Change the Primary Display field to UCR Type.

5. Scroll down through the list and find the field called UCRType. What type of field is it? ______________ What is the field length set to? ______________.

6. For any good analysis, the key is to know your data and what is available to be analyzed. Analysts who only know the rudimentary sections of their data will do rudimentary work. Analysts who become intimate with their data and know a lot about every field will be able to do more in-depth and valid research and analysis.

7. For the first task we need to know how many DUI arrests/offenses there were along Bell Rd. We therefore need to limit this data to show us only those DUI offenses that are in the table. Our RMS system does not store arrest information per se, so we cannot give the sergeant actual counts of arrests. It is okay to say “no” now and then.
8. Using our old friend, Select by Attribute, search the Offense data where “UCRTYPE” = ‘DUI’ and click the OK button to run the search.

9. Turn on the Offense layer if it is not already on, and notice all the pretty blue points.

10. Right click the Offense layer and go to Selection ➔ Create Layer from Selected Features from the pop-up menu.

11. Turn off the Offenses theme, and leave only the new Selected offenses layer on.

12. To find the DUI offenses “along” Bell Rd, we need to select the Bell Rd street segments within the City of Glendale. Bell Rd runs from 5100 to 8300 W, so we need to do a Select by Attributes query on the street file with the SQL string of “STREET_NAM” = ‘BELL’ AND (“R_FROM_ADD” >= 5100 AND “R_FROM_ADD” <= 8300). Remember that the old math order of operations logic applies with every SQL query. In other words, where you place the and’s and or’s and the parentheses does make a difference on what gets calculated first, and thus, the final answer. Click Verify. If you receive an error message, double check that your characters and spacing are correct.

13. We could also interactively click on Bell Rd with the Interactive Select tool, but we would need to make sure we get every single street segment and do not miss one.

14. An alternative process would be to use a Select by Location search and find all the streets that intersect the city boundaries, and then use a Select by Attributes query to whittle the results down to just Bell Rd.

15. Choose one of these options to get Bell Rd within the city limits selected.

16. Open up the ArcToolbox (little red toolbox in the menu bar) for the next step.

17. Click on the Analysis Tools toolbox, and then Proximity Analysis to open it, and double click on the Buffer tool to open the dialog menu (see DVD Figure 6–1)

18. Pick the Streets theme as the layer we are going to create the buffer around, and set the buffer distance to 0.10 miles. Save the file as BufferofBellRd.shp in your student folder, and click OK to run the tool.

19. Close the ArcToolbox.
20. Find the new theme in the TOC and turn it on. If it is not in the TOC, click the Add button, find your new buffer, and add it to the project.

21. Zoom in on the new buffer by right clicking the new theme and choosing Zoom to Layer from the pop-up menu.

22. If we open the attribute table and view the new theme, we can see that it is really 24 separate buffers around the two different street segments that make up Bell Rd between 5100 and 8300 West. Open the attribute table for the Streets theme and see that there are 24 street segments selected as well (see DVD Figure 6–2)

23. Let’s re-create this buffer, but this time we will make it one buffer for the entire section of Bell Rd.

24. We will turn on the ArcToolbox again, find Analysis ToolsÆBuffer, and enter the same information in the dialog menu, except in the field named Dissolve Type (Optional) we will pick All. This means we will dissolve the borders of the buffer parts wherever they touch each other. Name the output theme BufferofBellRd2.shp

25. Apply the Buffer tool and then turn off the first buffer and turn on the new one.

26. Now we wind up with a single buffer of all of Bell Rd that was selected (see DVD Figure 6–3)

27. Save your project!

28. This creates a permanent area (shapefile) of our research section, and if we ever need to redo this analysis, we can because this is a shapefile and not simply a graphic on the display that we have to delete to get it out of our way when we are not using it.

29. Now, use the Select by Location search to find all of the records in the Offense_Data Selection theme that intersect the BufferofBellRd2.shp.

30. We wind up with 213 offenses selected in the table.


32. At this point it is wiser to export our 213 records as their very own shapefile than continue working with virtual copies of the data (remember that the layer file is only a temporary thing).

33. Save your project again!

34. Right click the Offense_Data Selection and Export the selected records to your student folder as DUIonBell.shp. Say Yes to add the exported data to the map as a layer.
35. Remove the Offense_Data Selection theme completely by right clicking it and choosing Remove from the pop-up menu.

36. You could also delete the buffers you created because they are shapefiles and you can load them back in at any time if you need them. Keeping the TOC uncluttered goes a long way in helping to keep yourself organized when there are multiple steps needed in any analysis effort.

37. Open the attribute table of the DUIonBell.shp file from the TOC and click on Options → Add Field (see DVD Figure 6–4).

38. Add a new text field or integer field called Year. I prefer using a text field, and it only needs to be four characters wide.

39. When the field has been added, right click the Year field name and choose Field Calculator from the pop-up menu.

40. If you had browsed the Offense data in detail, you would have seen that the Midpoint field was a Date-type field. We can pull the year out of this field using date parameter queries here in the field calculator. In Fields, select Midpoint by clicking once.

41. In the field calculator menu, find the check boxes that allow you to choose the type of field you are making a query for and check the “Date” choice.

42. Double click the Datepart() function to bring it into the SQL query window (see DVD Figure 6–5), and edit it as follows:

```
DatePart ("yyyy", [MIDPOINT] )
```

43. Click OK to run the SQL code.

44. You should now see the year in each of the records of this field.

45. Right click the Year field name and choose Summarize.

46. Save the new file as DUIYrSum.dbf in your student folder. Click OK.

47. Click Yes to add the results to the project. Remember to click the Source tab in the TOC to view your new table.

48. Open the new table, and you should see a new summary table showing the count of DUI offenses along Bell Rd for each year.

49. You should be able to see that the DUI offenses are increasing from year to year. You can advise the motor sergeant of this information and send him an Excel copy or cut and paste this information directly into an e-mail reply.

50. Save your project!

51. Clear any layers of selected items using the Selection → Clear Selected Features menu item, and prepare for the next buffer exercise.
Task 2: Buffering Polygons to Find Auto Thefts

1. In task 2 we are going to search for auto thefts “around” Bonsall Park. Because we are very smart and talented, we are going to define “around” to mean within 0.25 miles of the park(s).

2. Turn on the City Parks theme, and use a Select by Attributes query to find Bonsall Park. Make sure you use an SQL query such as “NAME” LIKE ‘Bonsall%’ to get both parks that have “Bonsall” in the name.

3. Zoom in on the selected parks (right click the theme, then Selection, and then Choose Zoom to Selected Features).

4. You may want to click the Zoom Out button in the Standard toolbar a few times to get away from the park a little bit after you have zoomed in.

5. We are going to use a new buffer tool for this effort, which is called the Buffer Wizard.

6. To use this tool we need to customize the ArcMap project interface and add a button to our toolbar for this wizard. For some reason ESRI hid this tool, but it is very easy to use and is something I automatically put on my toolbar whenever I am working with a new copy of ArcMap on any PC.

7. To add new functions and tools, we need to go to Tools in the menu bar and then pick Customize from the pop-up menu (see DVD Figure 6–6).

8. Click the Commands tab, and then type the word buffer in the Show Commands Containing box.

9. Notice that the choices on the left are reduced based on what we typed.

10. On the left side we see Editor, Selection, and Tools. Click once on Tools. On the right side, you will now see an icon and the words Buffer Wizard.

11. Drag and drop this icon onto any toolbar. I generally drop it on the Main toolbar near where we launch ArcCatalog from.

12. Close the Customize dialog menu.

13. Now click the Buffer Wizard icon on the toolbar.

14. Set the theme to be buffered to the City Parks theme, and make sure the Selected Records item is checked (because we only want buffers around the Bonsall Parks and not all parks). Click Next.

15. Set the At a Specified Distance box to 0.25, and change the Distance Units field to Miles. Click Next.
16. Dissolve Barriers Between Buffers should be set to Yes.
17. Click on the check box next to Only Outside the Polygon(s).
18. Save the new layer in your student folder as BonsallBuffer.shp.
19. Click Finish.
20. Zoom to the BonsallBuffer theme when it is added back into the TOC (right click and zoom to the layer).
21. Double click the BonsallBuffer theme, and go to Properties → Symbology and change the symbol to a hollow box with a line at 2 points and the color red.
22. Now go to Selection → Clear Selected Features to clear any selections we may have on any data.
23. Use a Select by Location search to find all offenses from the Offenses theme (the original theme, not the selected DUI theme that you made) that intersect the BonsallBuffer theme (see DVD Figure 6–7).
24. You should get around 3664 offenses selected in the Offense Data theme.
25. Now we need to trim this list down to just the auto thefts.
26. Do a Select by Attributes search with the following settings:
   Layer: Offense_Data
   Method: Select from current selection
   SQL Code: “UCRTYPE” = ‘AUTO THEFT’
27. Click OK to apply the new selection, and browse your attribute table to see that you now only have 240 records selected. Show only the selected records, and verify that they are all auto thefts.
28. Turn the Offense theme on, and right click it. Choose Data → Export from the pop-up menu.
29. Export these selected auto thefts to your student folder as Bonsall AutoThefts.shp and add the new layer into your project.
30. Turn on the new layer and turn off the Offense_Data theme completely.
31. Now we need to whittle these 240 records down to just those that occurred in 2004.
32. Use a Select by Attributes query again, and use the following SQL code:
   “MIDPOINT” >= date ‘2004-01-01’
33. Change the method from Selection from Current Selection back to Create New Selection, then apply the query.

34. The answer for task 2 is 69 auto thefts occurred within 0.25 miles of the Bonsall Parks South and North. Save your results and the project.

**Task 3: Schools and Time Queries**

1. This task will be about the same as the previous tasks, only this time we are going to summarize data from two different time frames and use a slightly larger buffer around Glendale High School.

2. First, find and select **Glendale High School**.

3. The easiest way to do this is to simply open the attribute table, sort the school names in ascending order, and scroll down through the list until you find Glendale High School. Then click on the empty box to the far left of the record to select it.

4. If we are going to do this analysis periodically, we will want to create a permanent buffer shapefile at a distance of 1 mile area around the school. If we know we are only going to do this once, a **Select by Location** search may be fastest and easiest.

5. I am going to use the **Buffer Wizard** tool to create my buffer at 1 mile.

6. Complete this step as you choose.

7. Select just the kinds of data you want to analyze from the source theme (Offense_Data in this case).

8. We want only vandalism offenses for this analysis.

9. I will create a theme definition for my Offense_Data theme where “UCRTYPE” = ‘VANDALISM’ first, and then use a **Select by Location** query to choose those vandalisms that intersect the buffer of Glendale High School.

10. I got 1886 offenses. If you got more than this, you may not have cleared the previously selected features from task 2. Clear all selected features and redo steps 1–9. Did you get 1886 this time?

11. Using a field already in the Offense_Data attributes, I created the offense data table shown in DVD Figure 6–8.

12. Does it look like the time frames of 0700 to 0800 hours or 1400 to 1600 hours are more problematic than other times?_________________
CHAPTER 3  Environmental Criminology

13. The offense data table represents all vandalisms, and the officer believes that the juveniles are involved in vandalism of residences near the school. What other searches and information might you have to pull to answer this question realistically? (Hint: Look at your attribute table.) ________________________________________________

____________________________________________________

____________________________________________________

____________________________________________________

____________________________________________________

____________________________________________________

14. Which concern of the officer can you probably answer? __________

15. Save your project, clear any selections, and remove any layers you do not need for the next task.

Task 4: Bike Paths

1. For this task you are on your own. Think out the steps needed to do the analysis. Generally these include:
   a. Turn off any unnecessary layers to avoid confusion.
   b. Find the theme that is the subject of the analysis (the feature that applies to proximities such as around, near, close to, intersects, completely within, etc.). Remember the Find Address tool in the Standard toolbar that looks like binoculars. If an address locator does not show up, use ArcToolbox to create one as we did in exercise 4a.
   c. Select records from the Point, Line, or Polygon theme that is the subject of the analysis (the bike path).
   d. Create a buffer “around” those selected records at a logical distance (use the Measure tool to see how far away incidents generally are from the selected features).
   e. Select the target theme records that meet the criteria needed in the final result (robberies and indecent exposures).
   f. Create a temporary layer or a new shapefile of just those types of records.
   g. Use a Select by Location search to limit the target layer’s records to just those within the buffer in step b.
   h. Export your final results as a DBF, bring them into Excel, and create a lovely report.

2. Using a 0.5 mile buffer distance, you should get approximately 66 total offenses broken down as shown in DVD Figure 6–9.
3. Good luck, and if you have any problems, request assistance from the instructor.
4. Save your project!

References


